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1 Introduction

This protocol describes how to:

Produce and purify recombinant human and mouse a-synuclein in monomeric form from
transformed bacteria

Generate a-synuclein preformed fibrils (PFFs) from recombinant monomeric a-synuclein
Fluorescently label a-synuclein PFFs

Using conventional methods for bacterial transformation and large-scale protein expression,
plasmids containing glutathione S-transferase (GST)—-tagged full-length recombinant human
(NM_000345) or mouse (NM_001042451) a-synuclein are expressed in BL21 (DE3)
Escherichia coli (Figure 1). In parallel, a plasmid containing GST-tagged recombinant 3C
enzyme, which is capable of cleaving the GST tag from GST-tagged proteins, is also expressed.
The GST-tagged proteins are purified from the bacterial cell lysates by affinity column
chromatography.

The purified GST-a-synuclein protein is treated with GST-3C enzyme to remove the GST tag.
Untagged a-synuclein protein is purified from the reaction using affinity column chromatography
and then further purified using size exclusion chromatography.

The recombinant monomeric a-synuclein protein can be used for experiments directly, or for
generating PFFs through aggregation. PFFs can then be fluorescently labelled if desired,
depending on the experiment.
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Figure 1. Protocol overview for the expression and purification of GST-tagged a-synuclein (GST-a-syn) and
3C enzyme (GST-3C), cleavage of GST tags and purification of untagged a-synuclein, and generation of a-

synuclein PFFs.

Untagged a-synuclein protein (monomeric form) should be tested for bacterial endotoxin to
ensure that levels are below the threshold for the endotoxic response in mice and human cells.
Note that some animal species have a lower threshold for the endotoxic response and can only
tolerate proteins produced in bacterial strains with a disabled endotoxin signal (e.g. ClearColi
bacteria must be used to produce a-synuclein for marmosets).

The following information should be read before starting:

All material and reagents should be sterile or autoclaved:

Glass flasks should be capped with aluminum foil and autoclaved to sterilize.
Lysogeny broth (LB) medium should be autoclaved on the liquid cycle for 30 minutes
exposure time at 121°C to sterilize. After autoclaving, cool LB medium to room

temperature before using.

Use deionized, distilled water (ddH2O; MiliQ water) to prepare all media and buffers. Do not
use distilled water (dH2O) because it is too acidic for bacterial and protein work.
Use sterile technique and work over a flame during procedures involving bacterial cells and

cultures.

During the first procedure of expressing and purifying the GST-tagged proteins (section 3.1),
it is possible to pause prior to sonication of the bacterial culture.
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Following purification of the GST-tagged proteins (section 3.1), it is necessary to proceed
directly to the cleavage reaction (section 3.2). The purified GST-tagged proteins are sensitive
to degradation should not be stored to perform cleavage reaction at a later time.

All users of the AKTA pure protein purification system must be trained. The Superdex 200
16/600 columns should be used with care following proper training.

All users of the Bioruptor Plus sonication device and water cooler must be trained.

While working with a-synuclein PFFs:

Wear appropriate personal protective equipment at all times, including disposable gloves,
a laboratory coat, a face mask, and protective goggles.

Perform all procedures in a sterile Class Il biosafety (BSLII) cabinet.

Avoid inhaling PFFs or getting aerosolized PFFs in eyes.

After working with a-synuclein PFFs:

Clean area with 1% SDS to destroy fibrils, then rinse area with sterile distilled water.
Dispose of all tips and tubes into a large empty bottle or a 50-mL tube containing 1%
SDS. Store items in 1% SDS for up to 2 hours to disassemble the PFFs.

Dispose of gloves and face mask in an autoclavable biohazard bag to be sterilized.

For further information on the use of SDS to break down a-synuclein PFFs, refer to Bousset
et al. 2016. J. Parkinson Dis. (6) 143—-151.

Store a-synuclein PFFs at —80°C and thaw at room temperature. Do not store PFFs on ice or
at 4 °C, as this causes dissociation and reduces activity. Avoid repeated freeze-thaw cycles.
Do not vortex a-synuclein PFFs.
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2 Materials

The material, reagents, and equipment listed in this document can be substituted for those
supplied by other manufacturers. However, the performance of the assay may not be the same
and may need to be optimized or redeveloped upon significant modifications to the materials
and/or methods.

Refer to the product data sheet from the supplier for further details on storage and preparation

instructions.
Item Supplier Catalogue #
Sterile needle, 22G 14" Becton Dickinson 305156
Aluminum foil Sigma Aldrich 2185140
Amicon Ultra-15 Centrifugal Millipore UFC900324
filter unit
Autoclave tape Fisher Scientific 15903
Chromatography columns, Thermo Scientific 29924
10-mL, disposable (with
stopcocks)’
Chromatography columns, BioRad 732-1000
20-mL, disposable (with
stopcocks)’
Column holder Fisher Scientific 22-036466
Cryovial Fisher Scientific 50-873-794
Erlenmeyer flask, glass, 125- | Sigma Aldrich CLS4980125
mL
Erlenmeyer flask, glass, 2-L Fisher Scientific FB5002000
Glass bottle with cap, 1-L Fisher Scientific C13951L
GSTrap 4B GE Healthcare Life Sciences | 28401745
Mini-PROTEAN® Tetra cell BioRad 1658004
Mini-PROTEAN® Tetra cell BioRad 1658021
casting module
Parafilm Sigma Aldrich P7793
Petri dish, 100 mm x 15 mm Fisher Scientific FB0875712
Plate, 96 deepwell Eppendorf 0030504305
Plate, 96-well, clear BD Falcon 351172
Polypropylene bottles, 500- Beckman Coulter 361691
mL
Polypropylene bottles, 50-mL | Beckman Coulter 361694
Slide-A-Lyzer™ MINI Dialysis | ThermoFisher Scientific 88400
Device, 3.5K MWCO, 0.5 mL
Spectrophotometer cuvette Sigma Aldrich C5416
Sterile disposable filter unit, ThermoFisher Scientific 566-0020
0.2-ym
Sterile syringe filter, 0.2-uym VWR 28145-501
Sterile syringe, 10-mL Becton Dickinson 309604
Sterile syringe, 1-mL Becton Dickinson 309628
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Item Supplier Catalogue #

Superdex 200 16/600 column | GE Healthcare Life Sciences | 28-9893-35

Support stand Fisher Scientific 22-260469

Tubes, 50-mL Fisher Scientific 14-959-49A

"Reusable chromatography columns may be used as an alternative to disposable columns (e.g. 50-mL
reusable chromatography columns [Bio-Rad Laboratories #7374251]).

Item Supplier Catalogue | Stock Working Storage
# conc. conc. temp.

Acetic Acid, Fisher A38-450LB | 100% Various RT

Glacial (Certified | Scientific

ACS)

Acrylamide/ BioRad 1610156 30% Various 4°C

bisacrylamide

(29:1), 30%

Agar BioShop AGA001 NA 15 g/L RT

Alexa Fluor™ Molecular A20000 5 mg/mL ~161 ug/mL | Stock:

488" Probes -20°C

Alexa Fluor™ Molecular A20003 5 mg/mL ~161 pyg/mL | Stock:

568 Probes —20°C

Alexa Fluor™ Molecular A20005 5 mg/mL ~161 yg/mL | Stock:

633 Probes -20°C

Ammonium Sigma Aldrich | A3678 10% 0.005% RT

persulphate

(APS)

Ampicillin Sigma Aldrich | A9393 100 mg/mL | 100 pg/mL Stock:
-20°C
Working: 4°C

Aprotinin Sigma Aldrich A1153 0.5mg/mL | 0.5 uyg/mL Storage:
-20°C
Working: 4°C

Benzamidine Sigma Aldrich 12072 0.5mg/mL | 0.5 uyg/mL Storage:
-20°C
Working: 4°C

BL21(DE3) New England C2527H NA NA -80°C

Competent E. Biolabs

coli cells

Bradford Assay | ThermoFisher | 23236 NA NA 4°C

Kit Scientific

Bromophenol Sigma Aldrich B0126 100% 0.1% RT

blue

Coomassie BioRad 1610786 100% 100% RT

stain, Bio-

Safe™

Dimethyl Sigma Aldrich D8418 NA NA RT

sulfoxide

(DMSO)
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Item Supplier Catalogue | Stock Working Storage
# conc. conc. temp.
Dithiothreitol Biobasic DB0058 1M Various Stock:
(DTT) -20°C
Working: RT
Ethanol (EtOH) | Fisher PO6EAAN | 100% 20% (v/v) RT
Scientific
Glutathione Sigma Aldrich G4251 NA 20 mM 4°C
Glutathione GE Healthcare | 17075605 | NA NA 4°C
Sepharose bead | Life Sciences
slurry
Glycerol Fisher G331 100% Various RT
Scientific
Glycine Wisent 800-045-IK | NA 192 mM RT
Biosciences
GST-o- NA NA 100 ng/uL 2 ng/uL -20°C
synuclein
plasmid, human
GST-3C plasmid | NA NA 100 ng/uL 2 ng/uL -20°C
GST-o- NA NA 100 ng/uL 2 ng/uL -20°C
synuclein
plasmid, mouse
Isopropyl-3-D- Biobasic IBO168 0.5M 300 uM Stock:
thiogalactoside -20°C
(IPTG)
LAL Thermo 88282 NA NA 4°C
chromogenic Scientific
endotoxin
quantification
kit
LB broth (Miller) | BioShop LBL407 NA 25 g/L RT
Leupeptin Sigma Aldrich L2884 0.5mg/mL | 0.5 pg/mL Stock:
-20°C
Working: 4°C
Methanol Fisher A412-1 100% 40% RT
(Certified ACS) | Scientific
Paraform- Thermo Fisher | 28908 100% 4% RT
aldehyde (PFA)
Phenylmethane- | Sigma Aldrich P7626 0.5M 5 mM Storage:
sulfonyl fluoride -20°C
(PMSF) Working: 4°C
Phosphate- Wisent 311-012 10x 1x RT
buffered saline Bioproducts
(PBS)
Protein BioRad 1610373 NA NA -20°C
molecular
weight
standards
SOC medium New England B9020S NA NA RT or 4°C
Biolabs
peugo EDDU-006-02 6 April 2020 ‘f? MCGlll




Item Supplier Catalogue | Stock Working Storage
# conc. conc. temp.
Sodium chloride | Wisent 600-08 NA 400 mM Working: 4°C
(NaCl) Bioproducts
Sodium dodecyl | Wisent 800-100 10% Various RT
sulfate (SDS) Bioproducts
Tetramethyl- BioShop TEMO001.50 | 100% Various 4°C
ethylene-
diamine
(TEMED)
Tris-HCI Wisent 600-126 Various Various RT
Bioproducts
Triton X Sigma Aldrich | X100 20% 0.5% Stock: RT
Working: 4°C

"Light-sensitive reagent. Stock and working aliquots should be covered in aluminum foil to minimize

exposure to light.

TThe LAL chromogenic endotoxin quantification kit contains components that are light-sensitive in
lyophilized form (LAL and chromogenic substrate). Light-sensitive components should be covered to

minimize exposure to light.

Item Supplier Catalogue #
AKTA pure L protein GE Healthcare Life Sciences | 29018224
purification system

Beckman Coulter Avanti J- Beckman Coulter BE-J25

25l centrifuge (with JLA-

10.500 and JA-25.50 rotors)

BioDrop DUO BioDrop 80-3006-61
Spectrophotometer

Bioruptor® Plus sonication Diagenode B01020001
device with metallic

soundproof box (B01200001)

and water cooler

(B02010003)

CPXH Series Ultrasonic Fisher Scientific 15-336-126
Cleaning Bath

Digital heating shaking ThermoFisher Scientific 88880027
drybath or thermomixer Eppendorf 2231000574
Ecotron Incubation Shaker INFORS HT Ecotron
(with cooling)

Fisherbrand Model 120 Sonic | Fisher Scientific NA

Dismembrator with sound
enclosure box

Getinge Castle Vacuum Getinge 700HC-E SERIES
Gravity Steam Sterilizer
(autoclave)
Heating block Eppendorf 5383000027
EDDU-006-02 7 April 2020 ‘f? MCGlll




Item Supplier Catalogue #
Infinite® 200 PRO series Tecan INF-MPLEX
plate reader
Low-speed orbital shaker Corning LSE 6780-FP
New Brunswick Innova 42 Eppendorf M1335-0010
incubator shaker
Nutating Mixer VWR 8207-202
PowerPac Universal Power BioRad 1645070
Supply
Reciprocal shaking bath Precision™ NA (discontinued)
Stirrer plate VWR 97042-706
Temperature-controlled Barnstead MaxQ
orbital shaker
Thermo Scientific Heraeus Fisher Scientific 75004518
Megafuge 40R Refrigerated
Centrifuge
UNICORN™ 7.0.2 software GE Healthcare Life Sciences | 29115456
Vortex mixer Corning LSE 6776
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3 Protocol

Materials:

BL21 (DE3) competent E. coli cells
Plasmid(s):

Human GST-a-synuclein expression plasmid (100 ng/uL)
Mouse GST-a-synuclein expression plasmid (100 ng/uL)
GST-3C enzyme expression plasmid (100 ng/uL)

SOC medium

Ampicillin (100 mg/mL)

125-mL Erlenmeyer flasks

2-L Erlenmeyer flasks

500-mL capped polypropylene bottles

50-mL capped polypropylene bottles

50-mL tubes

0.2-pum sterile syringe filter and 22G 174" sterile needle
10- or 20-mL disposable chromatography columns
Support stand and column holder

Amicon Ultra-15 Centrifugal Filter Unit

Parafilm

IPTG (0.5 M)

1x PBS

20% EtOH in ddH>0

Glutathione sepharose bead slurry
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Solutions:

Solution Components

LB medium (autoclaved) 1L ddH20
25 g LB broth

Resuspension buffer (80 mL; prepare fresh ddH»O

and chill on ice before use) 25 mM Tris, pH 8

400 mM NacCl

5% glycerol

0.5% Triton X

5 mM PMSF

0.5 mg/mL benzamidine
0.5 pg/mL leupeptin

0.5 pyg/mL aprotinin
1mMDTT

Wash buffer (500 mL; chill on ice) ddHO

50 mM Tris, pH 8

400 mM NaCl

5% glycerol

1 mM DTT (add fresh before use)

Elution buffer (20 mL; prepare fresh and chill Wash buffer
on ice before use) 20 mM glutathione (once dissolved adjust
pH to 8)

LB agar plates containing 100 ug/mL ampicillin (see Appendix 4.4 for procedure)
SDS-PAGE and gel staining materials (see Appendix 4.8 for procedure)
Bradford Assay kit and materials (see Appendix 4.6 for procedure)

42°C water bath

Temperature-controlled orbital shaker

37°C bacterial incubator

Beckman Coulter Avanti J-25I centrifuge with JLA-10.500 and JA-25.50 rotors
Spectrophotometer and cuvettes

Fisherbrand Model 120 sonic dismembrator

Bioruptor Plus sonicator

Thermo Scientific Heraeus Megafuge 40R Refrigerated Centrifuge

Nutating mixer
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Procedure (for each plasmid):

1. Thaw vial of BL21 cells on ice for 10 minutes.
2. Add 1 pL (100 ng) of plasmid to the cells and gently flick the tube 4 to 5 times to mix.
Incubate cells on ice for 30 minutes.

Do not vortex cells to mix.

3. Place cells in a 42°C water bath for 10 seconds. Transfer cells to ice and incubate for 5
minutes.
4. Add 950 L of SOC medium to the cells. Shake cells at 200 rpm at 37°C for 1 hour.

During the incubation, warm LB-ampicillin agar plates to 37°C.

5. Spread 20 uL of cells onto warm LB-ampicillin agar plates and incubate plates at 37°C
overnight.

6. Add 20 mL of LB medium to a 125-mL Erlenmeyer flask. Add ampicillin to the medium to a
final concentration of 100 pg/mL.

7. Use a sterile 20 pL pipette tip to pick a single, isolated colony from the plate and eject it into
the flask containing the LB medium. Shake culture at 200 rpm at 37°C overnight.

Plates with colonies can be stored at 4°C for up to 1 month. For long-term storage of
transformed bacteria, prepare a glycerol stock (see Appendix 4.5 for procedure).
8. Add 500 mL of LB medium to each of four 2-L Erlenmeyer flasks. Add ampicillin to the
medium in each flask to a final concentration of 100 pg/mL.
Larger flasks may be used if available as long as the volume of medium is appropriate for
the flask size (e.g. 2 L of LB medium in one 8-L flask).

9. Transfer 5 mL of overnight culture to each of the 2-L flasks containing the LB medium.
Shake at 200 rpm at 37°C and 200 rpm. Monitor the optical density at 600 nm (ODeoo) until it
reaches 0.6 (see Appendix 4.7 for procedure).

It usually takes 3 to 5 hours or longer for the ODgqo to reach 0.6.

10. Add IPTG to the culture to a final concentration of 300 uM to induce protein expression.
Reduce shaker temperature to 16°C and shake culture at 200 rpm at 16°C for 18 hours
(overnight).
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11.

12.

13.

14.

15.

16.

Divide the culture among six 500-mL polypropylene bottles, ensuring that all filled bottles are
of equal weight. Close bottles with caps and centrifuge at 5000 G at 4°C for 30 minutes
using a JLA-10.500 rotor.

Place each bottle into a canister, and then place each canister into a cavity in the JLA-
10.500 rotor.

Place the rotor lid on top of the rotor and fasten the round knob securely into the
centrifuge.

Remove the supernatant and resuspend each pellet with 20 mL of cold resuspension buffer.
Combine the culture and divide into four 50-mL capped polypropylene bottles, ensuring that
both filled bottles are of equal weight (approximately 30 mL per bottle).

If necessary, the supernatant may be stored at —80°C until ready to sonicate. Once the
frozen supernatant has been thawed, proceed immediately to the next step.

Sonicate the cells on an ice bath using the sonic dismembrator on the following settings: 5
cycles; 30 seconds ON/30 seconds OFF, 60% power.

Close bottles with caps and centrifuge at 18,000 rpm at 4°C for 30 minutes using the JA-
25.50 rotor.

After the lysates have been cleared by centrifugation, transfer the supernatant from each
bottle into 50-mL tubes.

To check the expression level of GST-a-synuclein, run 100 uL of the supernatant (cleared
lysate) on a 14% polyacrylamide SDS-PAGE gel (see Appendix 4.8 for procedure).

Recombinant GST-a-synuclein will run at approximately 40 kDa on a 14% polyacrylamide
SDS-PAGE gel (Figure 2).
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Figure 2. 14% polyacrylamide SDS-PAGE gel of recombinant GST-a-synuclein (GST-a-syn) in BL-21 cell
lysate control (BL-21 —IPTG) and in BL-21 cell lysates induced with IPTG (BL-21 +IPTG).

17. Add 5 mL of glutathione sepharose bead slurry to two clean 50-mL tubes. Wash the beads
by adding 30 mL of ddH,O to each tube, centrifuge at 3000 rpm at 4°C for 3 minutes and
remove liquid.

18. Wash the beads by adding 30 mL of cold wash buffer to each tube, centrifuge at 4°C at
3000 rpm for 3 minutes and remove liquid. Repeat this step two more times.

19. Pass the cleared lysates (from step 16) through a 0.2-um sterile syringe filter into the 2
tubes containing the washed glutathione sepharose beads. Cap the tubes, seal with
Parafilm, and incubate on a nutating mixer at 4°C for at least 24 hours.
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20. Set up ten 10-mL or five 20-mL disposable chromatography columns in the column holders
on the support stand. Place a vessel (e.g. beaker) under each column to collect flow-
through. Transfer the lysate-bead mixtures to the columns. With the column stopcocks open,
wash beads five times with 15 mL of cold wash buffer.

The beads will be retained in the column, while the liquid will flow through the columns.

21. Close the column stopcocks and place 50-mL tubes under the column to collect eluents.

22. Add 3 mL of cold elution buffer to each column and incubate for 10 minutes. Slightly open
the column stopcocks and allow the eluents to drip into the 50-mL tubes. Repeat this step
three more times.

The beads can be re-used to purify the same protein. Wash the columns containing the
beads three times with 5 mL wash buffer then rinse three times with 5 mL ddH.O. Add
20% EtOH to the column so that the beads are covered, and then transfer the bead
solution to a clean 50-mL tube. Beads can be stored at 4°C until the expiry date on
product label.

23. Combine the eluents and transfer to a single Amicon Ultra-15 Centrifugal Filter Unit.
Centrifuge at 3000 rpm at 4°C for 30 minutes.

24. Add 10 mL of PBS and centrifuge at 3000 rpm at 4°C for 30 minutes. Repeat this step three
times to concentrate the eluent to <4 mL.

25. Determine the protein concentration (see Appendix 4.6 for procedure).

26. Proceed immediately to Section 3.2 to remove the GST tag from the GST-a-synuclein
protein. Reserve 100 uL of GST-a-synuclein protein to analyze by SDS-PAGE (see Section
3.2, step 9).

IMPORTANT: Do not store purified protein overnight; proceed directly to cleavage
reaction. The purified protein is sensitive to degradation and should not be stored to
perform cleavage reaction at a later time.
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Materials:

Recombinant GST-a-synuclein protein

Recombinant GST-3C enzyme

1.5-mL microcentrifuge tubes

96 deepwell plate

Amicon Ultra-15 Centrifugal Filter Unit

Superdex 200 16/600 column

GSTrap 4B column

Support stand and column holder

SDS-PAGE and gel staining materials (see Appendix 4.8 for procedure)

1x PBS
20% EtOH in ddH0O
Solutions:
Solution Components
Wash buffer (500 mL; chill on ice) ddH>0O
50 mM Tris, pH 8
400 mM NacCl
1 mM DTT (add fresh before use)
Elution buffer (20 mL; prepare fresh and Wash buffer
chill on ice before use) 20 mM glutathione (once dissolved adjust
pH to 8)

Bradford Assay kit and materials (see Appendix 4.6 for procedure)

Thermo Scientific Heraeus Megafuge 40R Refrigerated Centrifuge

Ultrasonic cleaning bath

AKTA pure L protein purification system with UNICORN 7.0.2 software

LAL chromogenic endotoxin quantification kit and materials (see Appendix 4.10 for
procedure)

Procedure:

1. Add GST-3C enzyme to GST-a-synuclein at a 1:50 mass-to-mass ratio. Incubate reaction at
4°C overnight.

For example, add 0.3 mg of GST-3C enzyme (150 pL of 2 mg/mL stock solution) to 15
mg of GST-a-synuclein protein (3 mL of 5 mg/mL stock solution).
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Start equilibration of the Superdex 200 16/600 column on the AKTA pure L system. The
equilibration takes approximately 11 hours and should be run overnight so that the system is
ready for the samples the next day. See Appendix 4.9 for instructions to set up and run the
equilibration using the UNICORN software.

Set up a GSTrap 4B column in the support stand. Place a vessel (e.g. beaker) under the
column to collect flow-through. Wash column with 20 mL of ddH>O to remove EtOH, and
then wash with 20 mL of cold wash buffer.

Reserve 100 pL of reaction to analyze by SDS-PAGE. Inject the remaining reaction into the
GSTrap 4B column and collect the eluent in a 50-mL tube.

The column can be re-used to purify the same protein. Wash the column with 10 mL of
cold elution buffer, then 10 mL of ddH20, and then 10 mL of 20% EtOH. Store at 4°C until
the expiry date on the product label.

Transfer eluents to an Amicon Ultra-15 Centrifugal Filter Unit. Centrifuge at 3000 rpm at 4°C
for 30 to 45 minutes to concentrate the eluent to <4 mL.

Prepare filtered, sonicated PBS for the AKTA pure L system by passing 500 mL of PBS
through a 0.2-um sterile disposable filter unit and then sonicating for 3 minutes using an
ultrasonic cleaning bath.

Purify the concentrated eluent with the Superdex 200 16/600 column on the AKTA pure L
system. Run a sample method to fractionate the sample into a 96 deepwell plate, and then
run a cleaning method to clean the column. See Appendix 4.9 for instructions to set up and
run the sample and cleaning methods using the UNICORN software.

The sample method takes approximately 2 hours to run.
IMPORTANT: The column must be cleaned immediately after running the sample. The
cleaning method takes approximately 15 hours to run.

Transfer the combined desired sample fractions to an Amicon Ultra-15 Centrifugal Filter
Unit. Centrifuge at 3000 rpm at 4°C for 10 to 15 minutes.

EDDU-006-02 16 April 2020 ‘f? MCGlll




9. To check the purity of the untagged a-synuclein, run 20 pL of protein on a 14%
polyacrylamide SDS-PAGE gel alongside the 3C cleavage reaction (from step 3) and GST-
a-synuclein (from Section 3.1; see Appendix 4.8 for procedure).

Recombinant untagged a-synuclein will run at approximately 15 kDa on a 14%
polyacrylamide SDS-PAGE gel (Figure 3). The calculated molecular weight of a-
synuclein is 14.87 kDa based on its amino acid sequence.

<
& &£ & P

& \Q-ﬁ o
< ,"—3\
BE.
100 | — °
75 4 '
—-—
[

50 GST-3C

L

37 A GST-a-syn

—— GST
25 | -
20 | —

S .- o-syn

Figure 3. 14% polyacrylamide SDS-PAGE gel of GST-tagged a-synuclein (GST-a-syn), 3C protease
cleavage of the GST tag (3C cleavage), and purified untagged a-synuclein (a-syn).

10. Determine the protein concentration and adjust to 5 mg/mL with sterile PBS (see Appendix
4.6 for procedure). Prepare 500 pL aliquots in 1.5-mL autoclaved microtubes and store at —
80°C. Reserve 1 aliquot determine endotoxin levels (next step).

Depending on the downstream application, other aliquot volumes may be preferred (e.g.
20 pL, 50 pL).

Aliquots should be labelled with the batch number, name of protein, protein
concentration, and date.

11. Determine the endotoxin concentration of reserved aliquot (see Appendix 4.10 for
procedure).

When using this protocol, the endotoxin concentration is typically 100 to 1000 EU/mg of
protein when a-synuclein is produced in BL-21 cells, or <100 EU/mg of protein when a-
synuclein is produced in ClearColi cells.
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Materials:

Recombinant monomeric a-synuclein (500-pL aliquot; 5 mg/mL)
Parafilm

37°C digital heating shaking drybath or thermomixer

Bioruptor Plus sonicator

Procedure:

1. Seal the 500-uL aliquot of monomeric a-synuclein with Parafilm. Incubate in a 37°C digital
heating shaking drybath or thermomixer at 1000 rpm for 5 days.

2. Sonicate the PFFs on the following settings: 10 cycles, 30 seconds ON/30 seconds OFF,
high power, 10°C water circulation.

Ensure that the tube holder is balanced with tubes containing equal volumes.

3. Depending on the downstream application, prepare 20- to 100-pL aliquots of PFFs in 1.5-mL
tubes and store at -80°C.
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Materials:

a-synuclein PFFs

1.5-mL tubes

Aluminum foil

Slide-A-Lyzer dialysis device and 50-mL conical tube

Alexa-488, Alex-568, and/or Alexa-633 fluorescent dye (5 mg/mL in DMSO)
1x PBS

Bradford Assay Kit and materials (see Appendix 4.6 for procedure)

Orbital shaker at 4°C

Procedure:

1.

Add 5 pL of a fluorescent dye to 150 uL of a-synuclein PFFs and mix gently. Cover samples
with aluminum foil to protect from light and incubate at room temperature for 20 minutes.

IMPORTANT: Do not vortex PFFs.
Incubation time may vary depending on the dye. Refer to the incubation time
recommended by the manufacturer.

Add 1 mL of PBS to a dialysis device placed in the 50-mL conical tube. Let sit for 5 minutes
to ensure the membrane does not leak (replace the dialysis device if leaking). Empty the
dialysis device and remove from the tube.

Add 45 mL of PBS to the tube. Add the dye-PFFs mixture to the dialysis device and place
the dialysis device in the tube. Cap the tube, place on the orbital shaker at 4°C, and shake
at 150 rpm for at least 2 hours.

Ensure the membrane of the dialysis device is submerged in the PBS.

Remove the dialysis device from the tube to discard the PBS. Add 45 mL of fresh PBS to
the tube and replace the dialysis device. Cap the tube, place on the orbital shaker at 4°C,
and shake at 150 rpm for at least 2 hours.

Collect the labeled PFFs from the dialysis device. Prepare 20- to 50-uL aliquots in tube and
store at —80°C. Reserve an aliquot of labelled PFFs to determine the protein concentration.

IMPORTANT: Store all aliquots of labelled PFFs at —80°C before determining protein
concentration of reserved aliquot. Do not store PFFs on ice or at 4 °C, as this causes
dissociation and reduces activity.
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4 Appendix

The plasmid used to express human GST-a-synuclein is pGEX-6-alpha synuclein (backbone
plasmid: pGEX6P1) and was originally purchased from the University of Dundee MRC Protein
Phosphorylation and Ubiquitination Unit (#DU30005).

Map of pGEX-6-alpha synuclein:

(5284) Btgl BfuAI - BspMI (62)
(5176) Bsu36I ‘ lac operator]
\ /
\ / _EcoNI (268
\\ ‘ / P ra ( )

CAP binding site|

(4726) PluTL
(4724) SfoI_\
(4723) NarI* —=\
(4722) KasI~

(4533) EcoRV
(4494) BssHII

_MscI (465)
P

BstBI (655)
_Swal (685)

_Pasl (941)
-

(4264) BStEII-__ _BseRI (1165)
EcoRI (1282)
 BamHI (1304)
___BpulOI (1370)

“EaglI - NotI (1375)
" PfoI (1451)

ST PfIFI - Tth111I (1554)
BsaAI (1561)

| Zral (1658)
AatII (1660)

(4083) Miul~— GST-alpha synuclein

5384 bp

(3766) BStAPI
(3665) PFIMI

% PstI (2337)
(2579) AhdI Bsal (2513)
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Sequence of insert:

GGATCTATGGATGTATTCATGAAAGGACTTTCAAAGGCCAAGGAGGGAGTTGTGGCTGCT
GCTGAGAAAACCAAACAGGGTGTGGCAGAAGCAGCAGGAAAGACAAAAGAGGGTGTTCTC
TATGTAGGCTCCAAAACCAAGGAGGGAGTGGTGCATGGTGTGGCAACAGTGGCTGAGAAG
ACCAAAGAGCAAGTGACAAATGTTGGAGGAGCAGTGGTGACGGGTGTGACAGCAGTAGCC
CAGAAGACAGTGGAGGGAGCAGGGAGCATTGCAGCAGCCACTGGCTTTGTCAAAAAGGA
CCAGTTGGGCAAGAATGAAGAAGGAGCCCCACAGGAAGGAATTCTGGAAGATATGCCTGT
GGATCCTGACAATGAGGCTTATGAAATGCCTTCTGAGGAAGGGTATCAAGACTACGAACCT

GAAGCCTAAGCGGCCGC

Properties of recombinant human a-synuclein (untagged):

Amino acid sequence

GPLGSMDVFMKGLSKAKEGVVAAAEKTKQGVAEAAGKTKE
GVLYVGSKTKEGVVHGVATVAEKTKEQVTNVGGAVVTGVT
AVAQKTVEGAGSIAAATGFVKKDQLGKNEEGAPQEGILEDM
PVDPDNEAYEMPSEEGYQDYEPEA*

Molecular weight

14,871.61 DA

Theoretical pl

4.67

Extinction coefficient

5960 M' cm", at 280 nm measured in water

The plasmid used to express mouse GST-a-synuclein was created in the laboratory of Dr.
Edward Fon (Montreal Neurological Institute, McGill University) by cloning the complete coding
sequence for mouse a-synuclein into the pGEX6P1 backbone plasmid. The insert was
generated by GeneArt® Life Technologies (construct #15AB4CPC).

Please refer to the plasmid map in Appendix 4.1 for details on the pGEX6P1 backbone

plasmid.

neuro

EDDU-006-02

21 April 2020 %? MCGlll



Sequence of insert:

AGATACCCACAGCCCTCACGCACCGCACCTCCAACCAACCCGTCCCCTCCCTAGGAAGAG
GAGCGAAGGCACGAGGCAGGCGAGGGGCGGGGAGAGGCGCTGACAAATCAGCTGCGGG
GGCGACGTGAAGGAGCCAGGGAGCCAGAGCGCCCGGCAGCAGGCAGCAGACGGCAGGA
GACCAGCAGGTGTTCCCCCTGCCCCTGCCTGCCCTTGCCTCTTTCATTGAAATTAGATTGG
GGAAAACAGGAAGAATCGGAGTTCTTCAGAAGCCTAGGGAGCCGTGTGGAGCAAAAATAC
ATCTTTAGCCATGGATGTGTTCATGAAAGGACTTTCAAAGGCCAAGGAGGGAGTTGTGGCT
GCTGCTGAGAAAACCAAGCAGGGTGTGGCAGAGGCAGCTGGAAAGACAAAAGAGGGAGT
CCTCTATGTAGGTTCCAAAACTAAGGAAGGAGTGGTTCATGGAGTGACAACAGTGGCTGA
GAAGACCAAAGAGCAAGTGACAAATGTTGGAGGAGCAGTGGTGACTGGTGTGACAGCAGT
CGCTCAGAAGACAGTGGAGGGAGCTGGGAATATAGCTGCTGCCACTGGCTTTGTCAAGAA
GGACCAGATGGGCAAGGGTGAGGAGGGGTACCCACAGGAAGGAATCCTGGAAGACATGC
CTGTGGATCCTGGCAGTGAGGCTTATGAAATGCCTTCAGAGGAAGGCTACCAAGACTATG
AGCCTGAAGCCTAAGAATGTCATTGCACCCAATCTCCTAAGATCTGCCGGCTGCTCTTCCA
TGGCGTACAAGTGCTCAGTTCCAATGTGCCCAGTCATGACCTTTTCTCAAAGCTGTACAGT
GTGTTTCAAAGTCTTCCATCAGCAGTGATCGGCGTCCTGTACCTGCCCCTCAGCATCCCGG
TGCTCCCCTCTCACTACAGTGAAAACCTGGTAGCAGGGTCTTGTGTGCTGTGGATATTGTT
GTGGCTTCACACTTAAATTGTTAGAAGAAACTTAAAACACCTAAGTGACTACCACTTATTTCT
AAATCTTCATCGTTTTCTTTTTGTTGCTGTTCTTAAGAAGTTGTGATTTGCTCCAAGAGTTTT
AGGTGTCCTGAATGACTCTTTCTGTCTAAGAATGATGTGTTGTGAAATTTGTTAATATATATT
TTAAAATTATGTGAGCATGAGACTATGCACCTATAAATATTAATTTATGAATTTTACAGTTTT
GTGATGTGTTTTATTAACTTGTGTTTGTATATAAATGGTGGAAAATAAAATAAAATATTATCC
ATTGCAAAATCAAAAAAAAAAAAAAAAAA

Properties of recombinant mouse a-synuclein (untagged):

Amino acid sequence MDVFMKGLSKAKEGVVAAAEKTKQGVAEAAGKTKEGVLYV
GSKTKEGVVHGVTTVAEKTKEQVTNVGGAVVTGVTAVAQK
TVEGAGNIAAATGFVKKDQMGKGEEGYPQEGILEDMPVDP

GSEAYEMPSEEGYQDYEPEA
Molecular weight 14,485.22 Da
Theoretical pl 4.74
Extinction coefficient 7450 M' cm', at 280 nm measured in water
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The plasmid used to express GST-3C protease was created by cloning the coding sequence for
human rhinovirus (HRV) 3C protease into the pGEX-2T backbone plasmid.

Map of pGEX-2T-3C:

(4848) Btgl BfuAI - BSpMI (62)
(4740) Bsu36I ‘ | EcoNI (268)
\ / MscI (465)

BstBI (655)

(4290) PIUTI
_Swal (685)

(4288) Sfol
(4287) NarI*—
(4286) KasI~

(4153) Hpal —
(4097) EcoRV —
(4058) BsSHIL

BamHI (930)
Aval - BsoBI - TspMI - Xmal (935)

_/-BmeT110I (936)
~Smal (937)
. _EcoRI (940)

Pfol (1015)
=
.PfIFI - Tth111I (1118)
BsaAI (1125)

Zral (1222)
AatIl (1224)

(3858) Apal - BanIl
(3854) PspOMI'/»
(3828) BstEII

pGEX-2T
4948 bp

(3647) Miul——

(3330) BStAPI
(3229) PfIMI~
PstI (1901)

' Bsal (2077)
/
(2622) AlwNI AhdI (2143)

-
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Properties of recombinant HRV 3C protease (untagged):

Amino acid sequence AFRPCNVNTKIGNAKCCPFVCGKAVTFKDRSTCSTYNLSSS
LHHILEEDKRRRQVVDVMSAIFQGPISLDAPPPPAIADLLQSYV
RTPRVIKYCQIIMGHPAECQVERDLNIANSIIAIIANIISIAGIIFVI
YKLFCSLQGPYSGEPKPKTKVPERRVVAQGPEEEFGRSILK
NNTCVITTGNGKFTGLGIHDRILIPTHADPGREVQVNGVHTK
VLDSYDLYNRDGVKLEITVIQLDRNEKFRDIRKYIPETEDDYP
ECNLALSANQDEPTIIKVGDVVSYGNILLSGNQTARMLKYNY
PTKSGYCGGVLYKIGQILGIHVGGNGRDGFSAMLLRSYFTG
QIKVNKHATECGLPDIQTIHTPSKTKLQPSVFYDVFPGSKEPA

VLTDNDPRLEVNFKEA
Molecular weight 44351.97
Theoretical pl 8.50
Extinction coefficient 23100 M-" cm, at 280 nm measured in water (assuming all

pairs of Cys residues form cystines)

Materials:

1-L glass bottle with cap
Petri dishes

LB broth

Agar

Ampicillin (100 mg/mL)

Procedure:

1. Add 12.5 g LB broth and 7.5 g agar to the 1-L glass bottle. Add ddH-O to the bottle to make
a total volume of 500 mL and autoclave on the liquid cycle.

2. Atter the autoclave cycle is complete, allow the LB agar medium to cool to approximately
42°C. Add 500 pL of ampicillin (final concentration of 100 pg/mL) and mix well.

3. Immediately pour the LB-ampicillin agar medium into the petri dishes (approximately 20 mL
per dish). Let the plates sit undisturbed at room temperature for 30 minutes to allow the
medium to solidify.

4. Transfer the plates into a sealed bag and store at 4°.

Materials:

Overnight bacterial culture

50% glycerol in ddH20

LB agar selection plate (containing appropriate antibiotic)
37°C bacterial incubator
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Procedure:

1. Add 500 uL of bacterial culture to 500 uL of 50% glycerol in a cryovial. Mix gently. Store at —
80°C.

2. To recover bacteria from the stock, use a 200 pL tip to scrape the surface of the frozen
solution and streak onto a warm LB agar selection plate. Store the remaining stock at —
80°C. Incubate plate at 37°C overnight.

Do not allow the glycerol stock to thaw during handling.

3. Colonies on plate may be used to grow a bacterial culture.

Materials:

Bradford Assay kit

Albumin Standard (BSA)

Samples of unknown concentration
Blank solution (sample solvent)
1.5-mL microcentrifuge tubes

Clear 96-well plate

Coomassie Reagent

Infinite 200 PRO series plate reader

Procedure:

1. Prepare standards by diluting the contents of 1 Albumin Standard (BSA) ampule into several
clean microcentrifuge tubes (2000 pg/mL—-25 pg/mL).
2. Pipette 5 L of blank, standard, or unknown sample in duplicate into a clear 96 well plate.

Blanks should be run in duplicate.

3. Add 250 pL of the Coomassie Reagent to each well and mix properly. Incubate plate for 10
minutes at room temperature.

4. Measure the absorbance at 595 nm using a plate reader.

5. Subtract the average measurements for the blank duplicates from all other individual
standard or sample measurements.

6. Prepare a standard curve by plotting the average blank-corrected measurement for each
BSA standard versus its concentration in ug/mL Use the standard curve to determine the
protein concentration of each unknown sample.
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Materials:

LB medium
Bacterial culture

Spectrophotometer and cuvettes
Samples of unknown optical density

Procedure:

-_—

Add 1 mL of LB medium to a disposable polystyrene spectrophotometer cuvette.

2. Place cuvette in spectrophotometer and measure the absorbance at a wavelength of 600
nm. This is the blank measurement.
3. Add 1 mL of bacterial culture to another cuvette and measure the absorbance at a

wavelength of 600 nm.

4. Subtract the blank absorbance value from to sample absorbance value to find the optical

density.

Materials:

Protein samples

Protein molecular weight standard
Gel casting module (casting stand, casting frame, comb, short plate, spacer plate)

Filter paper
100% EtOH

Tetra cell (electrode assembly, tank, lid with power cables, buffer dam)

PowerPac

Coomassie stain solution
Orbital shaker

Solutions:

Solution

Components

4% stacking gel solution (15
mL)

1.98 mL 30% acrylamide/bis-acrylamide
3.78 mL 0.5 M Tris-HCI, pH 6.8

150 pL 10% SDS

9 mL ddH20

15 uL TEMED (add just before pouring gel)
75 pL 10% APS (add just before pouring gel)

14% separating gel solution
(15 mL)

7.0 mL 30% acrylamide/bis-acrylamide

3.75 mL 1.5 M Tris-HCI, pH 8.8

150 pL 10% SDS

4.03 mL ddH20O

7.5 yL TEMED (add just before pouring gel)
75 pL 10% APS (add just before pouring gel)
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Solution Components

4x SDS loading buffer 200 mM Tris

8% SDS

40% glycerol

0.4% bromophenol blue

400 mM DTT

Dilute to 1x when preparing loading samples

10x SDS-PAGE running ddH-0

buffer 1% SDS

250 mM Tris

1.92 M glycine

Dilute 1:10 to prepare a 1x solution

Destain solution 50% ddH>.O
40% Methanol
10% Acetic acid

Procedure:

-_—

. Assemble glass cassette sandwich in the casting frame and secure on casting stand.

Add 10% APS and TEMED to the separating gel solution and fill the cassette sandwich up
to the point that will be approximately 1 cm below the teeth of the comb when inserted.
Overlay the gel solution with 100% EtOH. Leave separating gel undisturbed for 45 to 60
minutes to allow polymerization.

Pour off the alcohol overlay and rinse the top of the gel with ddH20. Dry the area above the
gel with filter paper. Partially insert the comb between the glass plates.

Add 10% APS and TEMD to the stacking gel solution and fill the cassette sandwich. Insert
the comb completely. Leave stacking gel undisturbed for 30 to 45 minutes to allow
polymerization.

Remove the comb and rinse wells ddH-0.

Prepare protein samples in 1x SDS loading buffer so that 1 to 5 ug of protein in a volume of
10 to 20 pL can be loaded per well.
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11.

12.

13.

14.
15.

Set the electrode assembly to the open position on a clean, flat surface. Place the gel
cassette in the electrode assembly.

Two cassettes are required to create a functioning assembly. When using 1 or 3 gels,
use the buffer dam (included with the cell) to complete the assembly.

Place the assembly into the tank. Fill the buffer chambers with 1x SDS-PAGE running
buffer.

Approximately 200 mL of buffer is required for the inner buffer chamber and
approximately 550 mL (for 1-2 gels) or 800 mL (for 3—4 gels) in the outer buffer chamber.

Remove the comb from the gel to allow the sample wells to fill with running buffer.

. Gently load 5 pL of protein ladder into the first well from the left. Load the remaining wells

with 10 to 20 pL of samples.

Secure the lid on the tank and connect the power cables to the PowerPac. Set the power
supply to constant voltage at 150 V. Run gel for approximately 1.5 hours or until the loading
dye front and/or molecular weight standards reach the desired position on the gel.
Disassemble the gel apparatus. Open the gel cassettes and transfer the gel to a container
containing 50 mL ddH»0. Place the container with the gel on an orbital shaker set to 50 rpm
and wash for 5 minutes. Discard the wash. Repeat this step 2 more times.

Add 30 mL of Coomassie stain solution to the gel. Shake until the blue protein bands
become visible (approximately 30 minutes).

Discard the stain solution and rinse gel with ddH20.

Add 50 mL destain solution to the gel. Shake until the gel background is clear and only the
blue protein bands are visible (2 hours to overnight).
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1. Turn on the AKTA pure L system and open the UNICORN software.

2. In the Administration window, under the Tools menu, select Method Editor from the

Tools menu.

3. Create a new method to equilibrate the Superdex 200 16/600 column.

<2 Administration

File  Reports

£ UNICORN User Setup...

€1 Access Groups and Network Users
| E-mail Setup

|, UNICORN and System Log...

. System Properties...

Database Management...

Column Handling... Ctrl+L

Method Editor

Systermn Control

Evaluation

Options...

Change Passwords...

Extension Management...

In the Method Editor window, select the New Method icon il or by selecting New
Method from the File menu.

#Neuro

Institut-Hopital

neurologique de Montréal

urological

Montre
Institute-Hospit

al

File
| NewMethod... . Clr
;| New Method Qusﬂe. o

| *) Open... Ctrl+0
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In the New Method window, select Gel Filtration (GF) under Predefined Method and

then select OK. A Method Navigator window will open.

Mew Method *

System:

AKTA2237212 ~

Create a new methed by using the:
(®) Predefined Method:
Gel Fittration (GF) ~

(O Empty Method:
Method Description

After equilibration and sample application, proteins separate and
elute according to their size (largest first).

o Cancel

In the Method Navigator window, select Method Settings and then enter the

parameters shown in the image:

J Phase Properties l Text Instructions T I

Method Settings Method Setings
Column selection
Show by technigue | Gel Filtration b4
Equilibration
Column type HiLoad 16/600 Superdex 200 pg S
v Show only suggested columns Column Properties...
Elution

Column volume ml
Pressure limit pre-column MPz [0.02 - 20.00] l',

Pressure limit delta-column 0.30| MPa [0.02 - 20.00]

Use flow restrictor
Column position |3 \/

Flow rate mifmin[0.000 - 25.000]

Control the flow to aveid overpressure

Inlet &

£2s neu ro EDDU-006-02 30
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Result Name & Location ...
Start Protocal...
Method Notes...

Unit selection

Method Base Unit Volume v

Flow Rate Unit

Manitor settings
UV variable wavelengths

Uy 1 [190- 700] nm
Juvz 254
Juv3a 214

Note! UV monitors with fixed
wavelength are not presented
in this view
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¢ In the Method Navigator window, select Equilibration and then enter the parameters
shown in the image:

J Phase Properties ] Text Instructions T ]

Method Settings Equilibration

Reset UV monitor (recommended if the equilibration occurs before the purification).
Equilibration

v [] Use the same flow rate as in Method Settings

Elution Flow rate mlimin [0.000 - 25.000] Inlet A
Inlet B % B[0.0- 100.0]

Fill the system with the selected buffer

Equilibrate until

(®) the total volume is 100.00| ml

() the following condition is met

Conductivity greater than
Conductivity greater than 0.00| mSicm [0.00 - 1000.00]
Accepted pH fluctuation 0.10| (0-14)

» In the Method Navigator window, select Elution and then enter the parameters shown
in the image:

J Phase Properties ] Text Instructions T ]

Method Settings Elution

[ Use the same flow rate as in Method Seftings Use the same inlets a5 in Method Settings

Flow rat 1.000| miimin  [0.000 - 25.000 Inlet A
Equilibration owrate | 1.000] miimin ] nlet A
Inlet B

¥ JUpflow i

Elution
() |socratic elution

Volume 180.96 ml 0.0| % B [0.0- 100.0]
(®) Gradient elution
Start at 100.0] % B [0.0- 100.0] [ Fill the system with the selected buffer
T
Target %B Length
tis @00 | )
1 |Linear w 1000 150.00 Add Segment

Delete Segment |

Mote: A gradient delay is automatically added, provided that the last gradient segment is linear

Fractionate actionation setting
@ in waste (do not collect) Fractionation type Fixed volume fractionation
() using cutlet valve Fractionation destination 96 deep well plate

Peak fractionation destination | 56 deep wel plate

() using fraction collsctor

Fraction collector Fixed fractionation volume

Pezk fractionation volume

fractionstion afte 2413 ml (only for isocratic elution)
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Save the method with unique file name.

4. Run the equilibration method.

Place line A1 into a flask containing ddH20 and line B1 into a flask containing filtered,
sonicated PBS. Seal the tops of the flasks with Parafilm.
In the Administration window, open the System Control from the Tools menu.

22 Administration

File  Reports

3

UNICORM User Setup...

Access Groups and Network Users
E-mail Setup

UNICORM and System Log...
System Properties...

Database Management...
Column Handling... Ctrl+L

Method Editor
System Control

Evaluation
Options...

Change Passwords...

Extension Management...

In the System Control window, select Open from the File menu. The Method Navigator

window will open.

B system Comrel - 8 X
Fle Edt View Manusl Sytem Took  Help
* g | =l
S |[» R
4| [ axmzzataiz =
Z| . unbata - x
Rec vome & o | [Rec_tme Block tme Scouting o Systemfow e |[ConcB injection [ | [Deitac prassor
Z [Ready o [omi 000 mn 000 min o 0,000 mlimin o0% Marual load Br-pass 000 1P [ooawea 007 1P
E VT 380 (0ER] (RN v and Cond i —_
= fooiees 0,000 miLl ) mAll 0000 maLl 001 mSfem [viaste WestetFrac)
|~ Chromatogram | - x
= w20
&0
500
o
a0
20
100
100
200
309
00
500
o o ) s 025 o 35 ¥ [ 5 oes 5 f E s 0ss
Process Picture | -x
0.000 0.0
Manualload 0.00 0.01
sa 0.000
_— N\ i
. e
W Ny pes 0V == cond == Waste)=— B
0.01
300
o
or
Run Log | -x
[ O Resdy R | e Wt | Cammectiori=="Commersedt I control | Cameset KTOP-CLRKESD [ ] C
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In the Method Navigator window, select your equilibration method. Select Start to run
the method. The method takes approximately 11 hours to run (can be run overnight).

Start Protocol - AKTA2237212 - Equil HiLoadS200 ON P
Result Name and Localion >>
Run info
Date:  [2018-07-05 5:09:10 PM -04:00 |
User: |Defauh |

Method: |Equil HiLoad5200 ON |

Resutt
[ No resutt
[ Add unique identifier to result name
Directory:
|f'Defau|tHome Browse. ..

Scouting subdirectory:

MName:
Equil HiLoadS200 ON 002

Q) Back Mext Cancel

Switch line A1 from the flask containing water to the flask containing PBS.
In the System Control window, right click on the @ in the Process Picture. Select Start
pump A wash to fill the line with PBS.

Manual load PreC 0.00 mPa  cCond 0.01 ms/cm
“ _5\\ Ew] ; Highalarm “5.00 Uy 1 0.000 oy Eﬁm
SyP F ——lBy-passT =—= U —— Cond =——= Waste —= ;_E;é
O, Gaehae
peltac  0.01 mpa
High alarm 3.00

5. Create a new method to run the sample.

In the Method Editor window, select the New Method icon = or by selecting New
Method from the File menu.

In the New Method window, select Gel Filtration (GF) under Predefined Method and
then select OK. A Method Navigator window will open.
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¢ In the Method Editor window, select Methods Settings and then enter the parameters

shown in the image:

J Phase Properties ] Text Instructions T ]
Method Settings Method Settings
Column selection Result Name & Location... |
Show by technique | Gel Filtration o
Equilibration 1 Start Protocol...
Column t i “
umn type _Hll:oad 16760 Superde:ZDD pa | Method Notes...
v Show only suggested columns Column Properties...
Unit selection
Sample Application .
Column volume Method Base Unit Volume  ~
Pressure limit pre-column MPa[0.02-2000] i,
v ” B2 2004 Flow Rte Uit
Pressure limit delta-column 0.30| MP=[0.02 - 20.00]
Elution Use flow restrictor Manitor settings
UV variable wavelengths
Column pesitien |3 ~| e [180-700] nm
Ouvz 254| [190-700] nm
El t 1.000| ml/min [0.000 - 25.000]
Flow rate _ ml/min [ 1] M3 [190-700] nm
Control the flow to avoid overpressure
Note! UV monitors with fixed
wavelength are not presented
Inlet A in this view

¢ In the Method Editor window, select Equilibration and then enter the parameters shown
in the image:

J Phase Properties ] Text Instructions T

Method Settings Reset UV monitor (recommended if the equilibration occurs before the purification).
[] Use the same flow rate as in Method Settings Jze the same i
Equilibration Flow rate mifmin [0.000 - 25.000] Inlet A
- Inlet B % B[0.0- 100.0]

Fill the syst: ith the selected buffs
Sample Application OFi system wi ¢l uffer

v
Equilibrate until

(@) the total volume is ml

() the following condition is met

Elution

Conductivity greater than
Conductivity greater than 0.00| mS/cm [0.00 - 1000.00]
Accepted pH fluctuation 0.10| (0-14)
Accepted UV fluctuation (.10 mAL {0.00 - 6000.00]

Accepted conductivity fluctuation 0.10| mS/em [0.00 - 300.00]

FENeuro
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¢ In the Method Editor window, select Sample Application and then enter the parameters
shown in the image:

J Phase Properties ] Text Instructions (T ]

Method Settings Sample Application

[] Use the same flow rate as in Method Settings

Flow rate 1.000| mil/min [0.000 - 25.000]
Equilibration [ 1.000] [ 1

v

(®) Inject sample from loop Fill the loop using | Manual load a5 b
Sample Application B Loop type | Capilary loop ~ Prime sample inlet with|  6.00| mi
- - Loop position 1

v Sample inlet Sample pump

Elution o 5 Mote! Buffer inlet A set in Method

Eill toor iy 0.60] mi Settings will be used to wash the

Empty loop with ol sample flow path

Sample volume 000 mi

Inlet A

Inet B . &

[ Fill the system with the selected buffer

Fractionate Frac tion settngs
(@) inwaste (donotcollecyy [ ractionation type Fixed volume fractionation
O using outlet valve Fractionation destination 56 deep well plate

ki s arkon il Peak fractionation destination | 96 deep well plate

Fraction collector Fixed fractionation volume

Peak fractionation volume
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In the Method Editor window, select Elution and then enter the parameters shown in the

image:
J Phase Properties ] Text Instructions T
Method Settings Elution
Use the same flow rate as in Method Settings
Flow rate 1.000| ml/min [0.000 - 25.000] Inlet &
Equilibration Ij : [ ! 7
Inlet B
v [JUpflow i
Sample Application
(®) Isocratic elution
v Volume [ 130.00] mi [ 00]%B00-1000 [] Fill the system with the selected buffer
Elution (O Gradient elution
Start at 0.0 % B [0.0- 100.0]
Linear w 100.0 200
Mote: A gradient delay is automatically added, provided that the |ast gradient segment is linear
Fractionate Fractionation settings
() in waste (do not collect) Fractionation type Fixed volume fractionation ™ Advanced
Settings...
() using outlet valve Fractionation destination 96 deep well plate ~

: : Peak fractionation destination |56 deep w
(®) using fraction collector = N - S L

B | Fixed fractionation volume mi [0.00 - 2.20]

Pezk fractionation volume 200 mi[0.00- 2 20]

Start fractionation after 35.00| ml (only for isocratic elution)

Save method with a unique file name.

6. Run the sample method.

Place a 96 deepwell plate in the fraction collector.

Clean the sample loop by injecting 10 mL of ddH»O, and then prime the sample loop by
injecting 10 mL of PBS.

Inject the sample.

In the System Control window, select Open from the File menu. The Method Navigator
window will open.

In the Method Navigator window, select your sample method and rename the file name

to the sample name. Select Start to run the method. The method takes approximately 2
hours to run.
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7. In the Evaluation window, visualize the sample fractionation. Collect and combine all
fractions from the desired peak.

In the example shown below, fractions D1-D11 should be collected.

53 Evaluation Clessie - [HiLoad $200pg GSTsyn 180704 001°]
[ File Edit View Iotegiste Operations Proceduies Tools . & x

v
LA S ) | B e (4] )| =0 |

Chrom.1

EEEEE R EEEES BT EETe

EEEEEEE

g8

f \

/ \_

[

> . | \

; i \

g EEEEFEEEEEREFEERRLECREEPEEEEEEERREREERECPRCRRRRRPREREEEr]

8. Create a new method to clean the column.

In the Method Editor window, select the New Method icon = or by selecting New

Method from the File menu.
In the New Method window, select Gel Filtration (GF) under Predefined Method and

then select OK. A Method Navigator window will open.
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¢ In the Method Editor window, select Methods Settings and then enter the parameters
shown in the image:

Method Settings

Equilibration

v

Elution

£ Neuro

Institut-Hopital
neurologique de Montréal
Montreal Neurological
Institute-Hospital

EDDU-006-02

J Phase Properties

] Text Instructions T

Flow rate

Infet A

Inlet B

Method Setlings
Column selection
Show by technique ' Gel Filtration v
Column type Hiload 16/600 Superdex 200 pg 7

7] Showonly suggested oo [ Column Propeties...

120637 ml
050| MPa[0.02-2000] i/

[ Pressure limit deta-column 0.30] MPa [0.02-2000]

Column volume

Pressure limit pre-column

Use flow restrictor

Column position |3 v

milmin  [0.000 - 25.000]

] Control the flow to avoid overpressure

| Resuk Mame & Location... |
Start Protocol....
Method Notes...
Unit selection
Method Base Unit | Vokume |

Flow Rate Unit

Monitor settings

UV variable wavelengths

uvi 280| [190-700] nm
Ouv2 254 [190-700] nm
Ouva 214| [190-700] nm

Note! UV monitors with fixed
wavelength are not presented
in this view

Enable pH monitoring

Enable air sensor alam

Column Logbook

Enable logging of

[ Column Performance Test
e
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¢ In the Method Editor window, select Equilibration and then enter the parameters shown
in the image:

J Phase Properties [ Text Instructions T ]
Method Settings Equilibration A
Reset UV monitor {recommended if the equilibration occurs befare the purification)
Equilibration
L 4 [] Use the same flow rate as in Method Settings 1
Elution Flow rate 1.000| ml/min [0.000 - 25.000] Inlet A
Inlet B [ 00] %Bi0o-1000)
[A Fill the system with the selected buffer
Equilibrate until
@® the totsl volumeis | 10000] mi
() the following condition is met
Conductivity greater than
Conductivity greater than 0.00| mSicm [0.00 - 1000.00]
Accepted pH fluctuation 0.10/ (0-14)
Accepted UV fluctuation 0.10| malU [0.00 - 6000.00]
Accepted conductivity fluctuation 0.10| mS/cm [0.00 - 300.00]
Stability time 1.00 min [0.02 - 1000.00]
Masximum equilibration volume 1206.37 ml
v
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In the Method Editor window, select Elution and then enter the parameters shown in the

image:
J Phase Properties Text Instructions T
Method Settings Elution 2
[] Use the same flow rate as in Method Settings
s Flowrate | 0.200| mUmin [0.000 - 25.000] Inlet A
Equilibration =" o
Inlet B
v O Upflow i
Elution
O Isocratic elution
Volume 180.956 mi 0.0 % B [0.0-100.0]
(@ Gradient elution
Stertat | 100.0| % B [0.0-100.0] [] Fill the system with the selected buffer
0 Target %B | Length |
s (0-100) mi)
1 [Linear w 100.0 150.00 Add Segment
Delete Segment
Mote: A gradient delay is automatically added, provided that the last gradient segment is linear
Fractionate
(@ in waste (do not collect) Fractionation type Fixed volume fractionation
O using outlet valve Fractionation destination 96 deep well plate
) i o colleckn Pesk fractionation destination |96 deep well plate
Fraction collector Fixed fractionation volume
Peak fractionation volume
24.13| ml (only for isocratic elution)
w

9. Run the cleaning method.

Place line A1 into the flask containing ddH20 and line B1 into 20% EtOH.

Clean the sample loop by injecting 10 mL of PBS, then 10 mL of ddH>O, and finally 10

mL of 20% EtOH.

In the Systems Control window, select Open from the File menu. The Method

Navigator window will open.

In the Method Navigator window, select your cleaning method and rename the file name
to the date. Select Start to run the method. The method takes approximately 15 hours to

run.
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Materials:

LAL chromogenic endotoxin quantification kit
Sample of unknown concentration

25% acetic acid (Stop Reagent)

1.5-mL microcentrifuge tubes

Clear 96-well plate

Infinite 200 PRO series plate reader

Heating block at 37°C

Vortex mixer

Timer

Procedure:

1. Reconstitute the vial of Endotoxin Standard by adding 1 mL of room temperature endotoxin-
free water. Vortex the solution vigorously for at least 15 minutes on a vortex mixer before
use.

The amount of the Endotoxin Standard is printed on the vial label (endotoxin units [EU]).
For example, a vial of 26 EU, when reconstituted with 1 mL of endotoxin-free water, will
yield a concentration of 26 EU/mL.

Reconstituted stock solution is stable at 2°C to 8°C for up to 4 weeks. Prior to
subsequent use, warm the solution to room temperature and vigorously mix for 15
minutes (endotoxin adheres to sides of the glass vial).

2. Prepare standards by diluting the reconstituted Endotoxin Standard in endotoxin-free water
in several clean microcentrifuge tubes (1 EU/mL-0.1 EU/mL).

Vigorously vortex each standard for at least 1 minute before use.

3. Reconstitute the LAL reagent immediately before use by adding 1.4 mL of endotoxin-free
water. Swirl gently to dissolve the powder.

Avoid foaming; do not vortex the solution.

If more than one vial is required, pool two or more vials before use.

Reconstituted LAL reagent is stable at —20°C or colder for up to 1 week if frozen
immediately after reconstitution. Thaw to room temperature and gently swirl the reagent
to mix before adding to samples. Once thawed, the reagent may be used only one time
and cannot be refrozen.
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10.
11.

12.

Reconstitute the Chromogenic Substrate by adding 6.5 mL of endotoxin-free water.

Reconstituted Chromogenic Substrate is stable at 2°C to 8°C for up to 4 weeks. Prior to
use, warm up sufficient substrate solution for the assay to 37°C.

Place the 96-well plate on the heating block for 10 minutes to equilibrate to 37°C.

Pipette 50 uL of blank (endotoxin-free water), standard, or unknown sample in duplicate into
the plate wells.

Add 50 pL of LAL reagent to each well and start the timer. Remove the plate from the
heating block and gently tap to mix. Replace the plate on the heating block and cover with
the lid. Incubate for 10 minutes.

When the timer reaches 10 minutes, add 100 uL of Chromogenic Substrate to each well.
Remove the plate from the heating block and gently tap to mix. Replace the plate on the
heating block and cover with the lid. Incubate for 6 minutes.

Add the Chromogenic Substrate in the same well order and with the same speed as the
LAL reagent was added.

When the timer reaches 16 minutes, add 100 L of Stop Reagent to each well. Remove the
plate from the heating block and gently tap to mix.

Measure the absorbance at 405 to 410 nm using a plate reader.

Subtract the average measurements for the blank duplicates from all other individual
standard or sample measurements.

Prepare a standard curve by plotting the average blank-corrected measurement for each
endotoxin standard versus its concentration in EU/mL Use the standard curve to determine
the endotoxin concentration of each unknown sample.
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